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About RadBlue

Radical Blue Gaming, Inc.
85 Keystone Avenue Suite F
Reno, Nevada 89503

call us: +1.775.329.0990
visit us: www.radblue.com
drop us an email: sales@radblue.com

Need help?

At the RadBlue forum you can find the latest release information, report issues, get your questions
answered, and submit suggestions for improving our products. Simply log on to:
http://radblue.mywowbb.com

Find out more about the GSA protocols

If you want to find out more about the Gaming Standards Association and the work being done in the
area of protocol standardization for the gaming industry, we encourage you to visit their website at
www.gamingstandards.com.
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Chapter 1: Installing RAS

About the RAS Installation
RAS is supported on Windows (32- or 64-bit): Windows Vista or Windows 7.

Pre-installation Requirements
1. You must have the RAS license file on your computer prior to installing RAS. If you are using a

special version of RAS , you must have a license for that version. If you have not received a RAS
license file, contact RadBlue Support.

2. If your computer does not have the latest required version of Java installed, you are prompted to
download and run the Java installer, or to navigate to the correct Java version.

Computer Requirements
The minimum requirements for computers running the analysis suite are:

l Operating System (32- or 64-bit): Windows (Vista or 7)
l Memory: 4 GB (minimum)
l Disk Space: 250 MB
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Install RAS
Follow these steps to install RAS.

1. Double-click RAS_x_x_x.exe.
2. Click Next.
3. Review the RadBlue click-through agreement, and select I accept the agreement to accept the

agreement.
4. Click Next.
5. Type the location where you want the RAS application installed, or click Browse to navigate to

the location.
6. Click Next.

If you have a previous version of the tool installed, you are prompted to remove it before
installing the new version. Click Next to uninstall the previous version before continuing with the
new installation, or click Back to install the new version in a different directory.

7. Navigate to the location of the RAS license file, and click Next.
For version 32 and higher, if you install a version of RAS over an existing version, you can choose
to use the existing license. If you do not want to use the existing license, you can browse to a new
license. Note that this option is only available when you install RAS over a previous installation.
All components of the previous installation are removed by the installer except the license file
and any backup files.

8. Select the Start Menu folder for RGS.
If you only want to create a shortcut for the current user, clear the Create shortcuts for all
users checkbox.

If you do not require a Start Menu folder for RAS, select Don’t create a Start Menu folder.

9. Click Finish.
10. Double-click the RAS desktop icon to launch the application.
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Uninstall RAS
You can uninstall RAS through the Uninstall option (Start > All Programs > RadBlue Analysis
Suite) or by running the uninstall.exe file in the RGS installation directory.

The following file and configuration options are saved in a backup file, allowing the specified
information to be retained between installations:

l RLT.vmoptions file
l Start in Full-Screen Mode parameter (under Desktop Options)
l Max G2S Transcript Messages parameter (under Desktop Options)
l Max Soap Transcript Messages parameter (under Desktop Options)
l Test Cases Location parameter (under Engine Options)
l All Artifact Analysis Tool Options
l All Email Options
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Chapter 2: Getting Started

About RAS
The RadBlue Analysis Suite (RAS) lets you do post-event analysis of G2S and S2S messages, using the
transcripts, logs and configuration data from:

l the gaming floor or integration center, generated through the RadBlue Protocol Analyzer (RPA)
l the EGM test lab, generated through the RadBlue G2S Simulator (RGS)
l the G2S host test lab, generated through the RadBlue System Tester (RST)
l the S2S test lab, generated through the RadBlue S2S Simulator (RSS)

An Export Data button on the debug log screen in each tool allows you to quickly and easily export
data (compressed into a Debug_*.zip file) to your desktop. Then, simply load the file into RAS and start
analyzing.
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A Debug_*.zip file can be easily created to snapshot the debug log and the transcript of G2S or S2S
message activity between a RadBlue tool and a target entity (G2S host, S2S server or EGM) or by the
RadBlue Protocol Analyzer (RPA) running between two endpoints (for example, a G2S host and an
EGM).

Once the debug log is exported to your desktop, simply upload it into RAS. Once loaded, you can
explore the various data files through the RAS viewer, transcript screen, and Advanced Transcript
Analyzer.

Viewing Transcripts Using RAS
Using the RAS interface, you can:

l import and view contents of debug files generated through RPA, RST and RGS.
l view and analyze transcript data.
l view and export error log data.
l create, delete and modify layouts and desktops.

You can view transcripts through the traditional transcript interface, including the Transcript report. If
you are analyzing G2S message data, you can explore transcript data through the Advanced Transcript
Analyzer, which compares messages with a set of rules. Once a comparison is complete, you can drill
down into messages to view any reported errors in the message XML.

In addition to transcript data, you can view the metadata and error log. The metadata file provides
information about the environment in which the data was generated - details from the product,
protocol, schema, license and configuration. For version 12 and lower, the available metadata will vary.

The error log displays all informational, warning and critical errors that occurred in the tool prior to
exporting the debug file.

Additional Resources
l RAS Release Notes

Supported GSA Versions
The following Gaming Standards Association (GSA) protocol versions are supported by RAS:

Protocol Versions

G2S 1.1.0 2.1.0

S2S 1.2.6 1.3.1 1.5.0
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The RAS User Interface
Let's look at the RAS interface.

Menu Bar (1)
From the menu bar you can access product options. Click an
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File

Option Description Screen

New Desktop

Select to create a new desktop. The desktop is a
collection of objects and tabs that constitute the
work area of the tool.

Type the name of the new desktop, and click Save

Open Desktop

Select to change the current desktop. When you
save a desktop, it becomes available in the Select
Desktop list.

Highlight the desktop you want to use, and click
Select.

Save Desktop

Select to save the current desktop. Once you save
a desktop, you can open it at any time by selecting
Open Desktop.

Click OK.

Add Layout

Select to add a new layout. The layout is a series
of tabs on the desktop, used to organize objects
by function. Within each layout, objects can be
placed next to each other, or on top of each other
(in which case they are accessed by object tabs).
Type the name of the new layout, and click Save.
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Option Description Screen

Remove Layout
Select to delete the currently displayed layout.

Click Yes to delete the layout.

Export Debug

Select to create a ZIP file of troubleshooting
information that can be sent to RadBlue support
or used with the RadBlue Analysis Suite (RAS).
Browse to the location where you want to save
the ZIP file, and click Save.

Exit Select to close the product.

Tools
Option Shortcut Description

Configure F2 Select to see configuration options.

Toggle Floor Tab F3 See Floor Tabs below.

GSA Message
Validator

F4
Allows you to paste in a sample XML document and see if the message is valid
against the selected schema.

Help
Option Description

RAS Help Select to launch RAS Help system.

Contact Us Select to open the contact page of the RadBlue web site.

About RAS Select to see the copyright, licensing, and verion information.
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Layout Tabs (2)
A series of tabs on the desktop, used to organize objects by function. Within each layout, objects can be
placed next to each other, or on top of each other (in which case they are accessed by object tabs).

Layout Tabs Description

Artifact Analysis Tool
Allows you to:
import and see debug files generated through the RPA, RST, and RGs
view and analyze transcript data

Debug Console Shows all informational, warning, and critical errors that occur in the tool.

Control Panel (3)
Use this panel to:

l Import debug files.
l Change G2S schema.
l Change the screen layout to see tree-structure file or not.

Floor Tabs (4)
Open/Close - The floor tab displays objects that you can drag and drop onto the Object Window when
you want to create a custom desktop or layout.

Open this window using the arrows on the interface screen, or by going to Tools > Toggle Floor Tabs.

This panel contains views that you can see when you click the bars: Controls and Tools.

l When you drag and drop an object from one of these views, the object opens as a tab.
l Click and hold the tab to open it into a floating window.
l When you find a custom layout, save that desktop, go to File > Save Desktop

About Objects - Objects contain a single function (or group of functions) that you work with in the
tool. They are populated from the tool's data model. The data model reflects all of the data that has
been captured by the tool and any updates that are received while the tool is running.

When you first start the tool, all of the objects are empty. As messages are received by the tool, the
appropriate objects are updated automatically. New objects are updated based on what's in the tool's
data model.

As a result, objects are immediately populated when dragged onto a layout, as long as the tool has been
running for a while and has received the applicable command. The same behavior holds true when
switching between desktops. If the command is in the data model, the object is automatically populated.
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Object Window (5)
The object window displays the content of the selected file. By default, display tabs are created for the
metadata, transcript and log files.

l File Explorer - Displays the content of the loaded file in a tree structure that you can browse.
Click any file to display its content in the display window. You can also drag and drop debug log
files into the panel to see them in the display window.

l To disable the automatic display of the transcript and log files, go to
Tools > Configure > Artifact Analysis Tool Options > uncheck:

l Autoload Log File and
l Autoload Message Transcript File

Double-click file tabs to detach them from the display window. You can use this feature to
compare the content of two files. For example:

About the Garbage Collector
The Garbage Collector lets you reclaim memory that is no longer in needed in order to improve tool
performance. To use the Garbage Collector, click the garbage can ( )icon in the lower right corner of
the user interface.
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RAS Configuration Overview
To get up and running on RAS, follow these steps.

Note: RAS is ready to use upon installation, without any special configuration.
However, as your work with the tool becomes more advanced, you may want to change the
default option settings.
For detailed information on RAS configuration options, see Customizing RAS.

1. Generate a Debug File in Another RadBlue Tool
2. Load a Debug File into RAS
3. Review Debug File Data

Generate Debug File in Another RadBlue Tool
The RadBlue System Tester (RST), RadBlue Protocol Analyzer (RPA) and RadBlue G2S Scope (RGS) all
have an Export Debug option that lets you create a ZIP file containing files to help you troubleshooting
G2S and S2S messaging issues.

1. Depending on the product, click the Debug Log tab or G2S Engine tab.
2. Click Export Debug.

A Debug-[product-x.x.x].zip file is exported to your computer’s desktop. This file is ready to be
imported into RAS.

Load a Debug File into RAS
Once you export a Debug_*.zip file from any RadBlue tool, you can load the file into RAS.

By default, the transcript and error log files are displayed automatically. If the tool that generated the
ZIP file uses a third-party schema, the RAS license must also support that schema.

If you have the Show Debug File Explorer option selected (Configure > Artifact Analysis Tool
Options), you can view any file by selecting it. Note that files with a .jks extension are encrypted and
cannot be viewed.

You can drag and drop individual files into the file explorer window to view them in RAS. Note that
these files do not become part of the loaded ZIP file and are retained by RAS when you exit the tool.

1. Go to the Import Debug File section of the Artifact Analysis Tool layout.
2. Click Import.
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3. Navigate to the Debug*.zip file you want to import.
4. Select the file, and click Open.

A progress bar displays, so you can track the progress of the import.

If the loaded ZIP file was generated by version 13 or later of a RadBlue tool, RAS automatically
determines the schema used. For older tool versions (or if you want to change the current schema):

1. Select themetadata.html tab.
2. Click the GSA Schema drop-down.
3. Select the schema in use when the ZIP file was generated.
4. Click Reload Data.

Review Debug File Data
The Debug_*.zip file contains logs, transcript and configuration files from the RadBlue tool from which
it was exported. RAS lets you view HTML, TXT and XML files. Keystore (JKS) files are encrypted and
cannot be viewed in RAS.

While the debug file contains lots of information for you to review, here are the files to start with when
analyzing messaging data:

l MetaData (metadata.html)
The metadata file provides information about the environment in which the data was generated -
details from the product, protocol, schema, license and configuration. For version 12 and lower,
the available metadata will vary.
The metadata file displays automatically.

l Transcript (transcript-gsa.g2t)
The transcript files show messages sent between two endpoints. Transcript files display in the
transcript interface, allowing you to view, sort, and drill down into the message XML.
From the transcript interface, you can generate the EGM Transcript Analysis report (Analyze >
General) for a user-friendly summary of all G2S messages.
The Advanced Transcript Analyzer can also be accessed through the transcript interface (Analyze
> Advanced). This feature compares messages with various rules to ensure that they meet G2S
protocol requirements. Messages with rule violation are flagged, and can be reviewed in detail.

l Error Log (radblue-g2s-engine.txt)
The error log displays all informational, warning and critical errors that occurred in the tool
prior to exporting the debug file.
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Chapter 3: Using the Advanced Transcript Analyzer

About the Advanced Transcript Analyzer
The Advanced Transcript Analyzer lets you easily verify that commands being sent by the EGM are
semantically valid. Visual cues let you easily discern which events have errors. You can then quickly drill
down to the message content level to view the issue.

The Advanced Transcript Analyzer validates:

l the event subscription set by the EGM is accurate when compared to the subscription requested
by the host.

l every eventReport command sent by the EGM to ensure that the EGM has included the
associated data agreed upon in the event subscription phase.

l selected attributes in the eventReport command to ensure that they properly indicate state
transitions as identified by the G2S protocol document.

The Advanced Transcript Analyzer makes it easy for EGM developers and testers to deliver high-quality
G2S implementations - and we’re continuing to add new areas of investigation (more “rules” to run
against your G2S application) to give you the most comprehensive testing possible.
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Review the Advanced Transcript Analyzer Layout
The Advanced Transcript Analyzer can be accessed by clicking Analyze > Advanced on the Transcript
layout.

Errors and warnings are displayed in the Results Tree on the left-hand side of the screen. Click the
plus sign to drill down to warnings and errors. To narrow the displayed results, click the Filter option
and choose to display warnings and errors only or specific classes only.

When you click on a command with an error or warning, all violations associated with the command
are displayed under Exceptions. Click an exception to display the message content, with the violation
highlighted, in the Message Content section. The Find option lets you search the message content.
Simply click inside the Find field and start typing.
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Get Started Analyzing Command Data
From the Transcript layout, click the Analyze drop-down arrow, and select Advanced.

1. Click the EGM ID drop-down arrow, and select the EGM data you want to analyze.
2. Click the Host drop-down arrow, and select the host data you want to analyze or select All

Hosts to view all host data.
3. Click in the Report dialog box, and type or select the number of rule violations you want to view.
4. Select Ignore keepAlives if you do not want to include keepAlive commands in your

analysis.
5. Enter the reporting period date and time in the Start Date and End Date fields. You can access a

calendar to select the date and time by clicking the drop-down arrow. By default, the dates reflect
the start and end of the Transcript. If you are using an older version of the Advanced Transcript
Analyzer, the default will reflect the current date and time.

6. Click Start Analysis Process.
Errors are organized by communication sessions (Comms Session). A Comms Session is the
period of time between two commsOnline commands. Comms Sessions that do not have any
significant data do not appear in the Advanced Transcript Analyzer.

When you click to highlight a Comms Session, a summary of that Comms Session displays under
Exceptions.
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Under each Comms Session, errors are grouped by class and then by rules.

A colored status icon appears in front of each grouping to let you know if there are any errors in
that group. The colors are defined as follows:

l Green - No errors or warnings. You’re good to go.
l Yellow - Warning. One or more issues that are permissible in the schema, but may cause
problems in your implementation.

l Red - Error. One or more G2S schema violations.
Look for red and yellow status icons. (If you only see green - Congratulations! Close the tool
and take a well-deserved break.)

6. Double-click a red- or yellow-status Comms Session to expand it.
7. Double-click a red- or yellow-status class to expand it.

Note: The same error may appear more than once if it violates more than one rule.

8. Click a command to display those errors in the Exceptions section.
9. Resize the Exceptions list as needed by clicking and dragging the sizing bar at the bottom of the

list.
10. Click any error in the Exceptions section.

The message in which the error occurs is displayed in the Message Cotentt section directly
below the Exceptions section. The issue within the message (for example, an invalid attribute
value) is highlighted.

You can use the Find option to search for keywords and character strings in the message
content. To use the Find option, click inside the Find text box, and start typing. Characters in the
first matching instance are highlighted in the message content as you type.

l Click Highlight to highlight all matching characters.
l Use Find Next and Find Previous to move from match to match within the message content.
l Select Match Case to view only matches in title case as well as character.

26 04 MAR 2014 - Version 38

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

Chapter 3: Using the Advanced Transcript Analyzer RAS User Guide



Filter Advanced Transcript Analysis Report
You can filter debug log data from the Advanced Transcript Analysis Report user interface through the
Filter option. Choose to view only violations (errors and warnings) or all data for a specific class.

1. From the transcript-gsa-ex1.xml Advanced TAR tab, select the Analysis Browser tab.

2. Click Filter.

3. Modify the displayed data as required.
l Show Violations Only - Select to display errors and warnings only.
l Filter by Device - Select any class to display its data. To omit a class from display, clear its
checkbox. By default, all classes are selected. Click Select All to select all classes or Clear All
to clear all classes.

4. Click Apply to save and automatically apply your changes.
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Generate a PDF of the Advanced Transcript Analysis Report
You can quickly generate a PDF file of all errors and warnings from the currently loaded debug log
through the Advanced Transcript Analyzer interface. This option gives you a succinct overview of all
issues and allows you to easily share your findings with others. You can choose to generate a report
with all errors (complete) or a report that excludes duplicate errors (summary).

Note that any filters you apply to the Advanced Transcript Analyzer interface are reflected in the report.

Sample Summary Report
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1. From the Advanced Transcript Analyzer screen, select the Analysis Browser tab.

2. Under the Result Tree, click Export PDF.
Note: If there are no errors in the imported debug log, the Export PDF option is disabled.

3. Click the Report Type drop-down arrow, and choose whether to generate all errors, including
duplicate errors (COMPLETE), or one incident, of each error type, per comms session
(SUMMARY).

4. Click the PDF Filename drop-down arrow.
5. Navigate to the location you want the file output to, and type a new file name as needed.
6. Click Open.
7. Click Export PDF Report.

8. Click OK.
A PDF file with the name you entered is created in the specified location.
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Chapter 4: Using the Message Transcript

Working with the Message Transcript
The Message Transcript lets you examine individual commands sent from, or received by, the tool. The
data displayed is extracted directly from received G2S or S2S messages (depending on the protocol you
are using).

Filtering options offer you a variety of ways to view information. Each instance of the transcript within
the tool can be filtered differently.

Depending on the version of the product debug.zip file you are importing, you will be able to view the
Message Transcript through either the transcript-gsa.xml (for older versions) or transcript2-gsa.g2t
(for newer versions). Note that the transcript-gsa.xml file does not support advanced features such as
linking to the g2sAck message, corresponding request-response pair command or the associated SOAP
message when viewing the details of a command.

At the top of the Transcript screen are several options:

l EGM Selector - Click the drop-down arrow, and select to view the transcript information for a
specific EGM, all EGMs or multiple EGMs (CTRL+click).

l Host Selector - Click the drop-down arrow, and select to view the transcript information for a
specific host system or all host systems.

l Compare - View the details of any two messages side-by-side.
l Filters - This control allows you to select which commands are to be included on the display.
Make any changes, and then press OK to have the tool update the display. This control currently
resets when a new data set is loaded.

l Search Content - Search through the contents of all displayed messages in this transcript
instance for the entered text pattern (case sensitive). Clicking on a row in the returned list gives
you access to the HTTP header and message contents of the selected message.

l Set Comment - Adds a comment to the Comment column of the selected message.
l Clear Display - Clears the displayed messages in this instance of the transcript control.
l Clear Database - Clears all records of this type in the database for this instance of the tool.
l Analyze - Available for G2S messaging only. Provides a user-friendly summary of transcript
messages.

The size limit of the Message Transcript file is 1 GB. Once the limit is reached, older records are purged.
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A Note on Converting Time in the Message Transcript
If the tool receives a date/time with the seconds parsed greater than milliseconds, the time/date is
truncated to milliseconds in the transcripts. For example:

The date/time 2013-04-30T08:03:46.1234567890-07:00

displays as 2013-04-30T08:03:46.123-07:00 in the transcript.

You can view the longer date/time format on the XML tab of the command object. To access the
command object, double-click any message in the transcript.

Transcript Column Headers
The following columns are available in the transcript:

l Command ID - Command ID associated with message.
l Comment - Information entered by the user about a specific message. This field is not part of the
actual message. Comments exist only in the tool in which they are entered.

l Date Received - Date and time message was received by the tool.
l Device - Class and identifier of device where the message is being sent to or from.
l Event Code - Code for associated event.
l Event Date/Time - Date and time that event was sent.
l Event ID - Identifier for associated event.
l Event Text - Description of associated event.
l From Location - Identifier of entity (for example, EGM or host) that sent the message.
l Message ID - Unique identifier associated with the message.
l Session ID - Session ID associated with message.
l Session Type - Indicates how the message should be processed: as a request, response or
notification.

l State - Message states are: Standard (G2S message with no errors), Error (G2S message with
errors), Comment (Comment made in CVT Message Transcript) and Special Error (CVT test
case error). Sorting the Message Transcript column on State, which you can do by clicking the
column header, lets you quickly identify messages with errors and comments.

l Summary - Actual G2S or S2S command within the message. If more than one command is sent
in a message, only the first command appears in the transcript. However, all commands with the
message are displayed in the detail view, which you can access by double-clicking the message.
For G2S_GPE112 (Game Ended) events, the outcome of game play (the playResult attribute)
is shown in the Summary column in brackets (for example, eventReport:G2S_GPE112 - Game
Ended [Lost]).
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l To Location - Identifier of the intended target of the message.
You can slide the columns around to rearrange their order. To move a column header, left-click and
hold while you move the column to it’s new location. You can also click any column to re-sort it, or use
CTRL + left-click to sort on multiple columns.

If you right-click on a column header, a menu displays that allows you to automatically resize one or all
columns (based on the displayed data in the columns), as well as to indicate which columns you would
like to display.

Clicking on any column header causes the data to be sorted using that header. Click once to sort the
column in ascending order. Click a again to sort the column in descending order. The third click clears
the sort.

If you want to sort on multiple columns, use the CTRL key when clicking the column headers.
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Filter Transcript Messages Using the Quick Filter
Just below the Transcript options is a magnifying glass and entry field that allows you to filter messages
based on entered data. To filter the displayed data, click inside the entry field and start typing. The
displayed data is automatically filtered as you type.

Clicking on the magnifying glass gives you a menu that you can use to provide additional selection
criteria.

This powerful tool allows you to immediately view any set of messages that you can imagine, limited
only by the data displayed in the columns.

What Are You Looking for in the Transcript?
l Are the correct commands being sent?
For example, is the commsOnLine command being sent during startup?

l Are messages being acknowledged (for example, with a g2sAck as well as a message
acknowledgements?

l Are there correct request‐response pairs?
For example, if a communications.getDescriptor command is sent (outbound), a
corresponding communications.descriptorList command should be received
(inbound). Note that the Session ID is the same for the request and response.
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Compare Messages in the Transcript
The Compare option lets you view the details of two messages, side-by-side. You can choose to view the
message content in three different formats: in a user-friendly format, XML format, and XML format with
the differences between the two messages highlighted in red.

The Compare option is available when you view the Event Report as well as in the main Message
Transcript.

1. While holding down the CTRL key, click the two messages you want to compare.
2. Click Compare.

The selected messages display side-by-side, allowing you to scroll through the details of each
message to compare them.

The Command tab displays command information in an easy-to-read format along with any
meters.

4. Click View XML to view the XML for the messages.
5. Click Diff to view the XML with the changes highlighted in red.
6. Click OK to close the compare view.
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Filter Messages in the Transcript
The Filters option in the Transcript lets you select the commands, events or devices you want to display
in the transcript window. Use this option to narrow the transcript view to just the messages that
interest you. The excluded data is not deleted from the transcript database; it is just not displayed and
can always be included again.

1. Open the transcript2-gsa.g2t file (located under logs in the file explorer), select the
transcript2-gsa.g2t tab.

2. Click Filters. The Filter Messages screen displays with three tabs: Commands, Events and Device.

3. On each tab, select the check box of the commands, events and devices you want to display in the
Transcript, and clear the check box of the commands, events and devices you want to hide.
By default, the g2sAck command is cleared (does not display).

4. Click OK.
Your changes take effect immediately.
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Search the Content of Transcript Messages
The Search Content option lets you search transcript message content for keywords.

1. Open the transcript2-gsa.g2t file (located under logs in the file explorer), select the
transcript2-gsa.g2t tab.

2. Click Search Content.

3. Type the keywords for your search, and click Proceed.
The Transcript Search Results screen displays all conforming messages.

4. To view the details of a message, double-click the message.
5. Click Back to close the Transcript Search Results window.

Scroll Through Transcript Messages in RAS
When using the RadBlue Analysis Suite (RAS), you load large transcript files into the Transcript viewer.
You can move quickly through the messages by using the toolbar located at the top of the Transcript
viewer.

To scroll forward through loaded Transcript messages, click Next 1000. To scroll backward through
the messages, click Previous 1000.

To jump to a group of messages, type a row number in the Goto Message field, and press Enter. For
example, if you want to view the messages halfway through a 10,000-message Transcript, type 5000
and press Enter.
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View Command Objects through the Transcript
A command object is a graphical representation of a command (as opposed to viewing the command in
XML format). You can view command objects on the message details screen. List information for
complex commands displays in tabs to the right of the command attributes. From the message details
screen you can link to the g2sAck message, corresponding request-response pair command or to the
associated SOAP message for any command. Attributes that are deprecated in G2S 2.1 display in a
strike-through font (for example, Enable Money Out). Comments associated with the message are
displayed next to the Command and View XML tabs.

To display a message’s command object:

1. Double-click the command you want to view.
2. Click the Command tab.
3. Click Previous and Next to navigate through the transcript list while in the message detail view.
4. Click g2sAck to view the corresponding acknowledgment to the selected command.
5. Click Req-Resp to view the corresponding command in the request-response pair.
6. Click the test case identifier to launch a browser window with information from the CVT Test

Case Encyclopedia for that test case.
7. Click OK to return to the transcript.
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View the Event Report
The Event Report displays all events sent and received by the tool. You can toggle between the
Transcript view and the event view by clicking Show/Hide Event Report. The Compare option lets
you compare two event messages.

1. Open the transcript2-gsa.g2t file (located under logs in the file explorer), select the
transcript2-gsa.g2t tab.

2. Click Show Event Report.

l Date Received - Date and time message was received by the tool.
l Event Code - Code associated with event (for example, G2S_VCE102).
l Event Date/Time - Date and time message was received by the tool.
l Event ID - Event identifier.
l Event Text - Text of associated event code (for example, Validation ID Data Updated).
l From Location - Identifier of entity (for example, EGM or host) that sent the event.
l Message ID - Message identifier.

3. Double-click any record to view the details of the message in which the event was sent.
4. Click OK to close the message detail screen.
5. Click Hide Event Report to return to the Transcript view.

04 MAR 2014 - Version 38 39

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

RAS User Guide Chapter 4: Using the Message Transcript



Add a Comment to a Transcript Message
The Set Comment option lets you add a comment to any message in the transcript. Comments are part
of the transcript only. Messages are not modified by comments.

Note: Comments associated with a message are displayed next to the Command and View XML
tabs when you view the message details.

1. Single-click the message to highlight it.
2. Click Set Comment.

3. Type your comment, and click Set Comment.
The message is highlighted in blue, and the comment appears in the Comment field.
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Export Transcript Entries
The Export to Transcript File option lets you quickly export all or select Transcript entries for review.
This file can then be imported into the RadBlue Analysis Suite (RAS) for further analysis.

This option is useful when an issue has been narrowed down to a limited set of commands. Rather than
exporting a large set of troubleshooting data using the Export Debug option on the Debug tab, you can
send only the specific command(s) involved in the issue.

You can import the Transcript file directly into RAS by using the Import option.

1. Open the transcript2-gsa.g2t file (located under logs in the file explorer), select the
transcript2-gsa.g2t tab.

2. Select the Transcript records you want to export.
There are several ways to select records:

a. Click to select a single record.
b. CTRL+click to select multiple records.
c. SHIFT+click to select a block of records. Click once on the first record and once on the last

record to highlight the entire block.
d. For another way to select a block of records, right-click and hold on the first row. Then, drag

the cursor down the screen, highlighting each row as you go, until you come to the last row
you want to export.

e. CTRL+a to select all Transcript records.
3. Right-click inside the Transcript, and select Export to Transcript File.
4. Type a name for the file.
5. Click the Files of Type drop-down arrow, and select either a S2S Transcript (*.s2t) or a G2S

Transcript (*.g2) file extension. Your selection corresponds to the protocol you are using with
the tool (either G2S or S2S).

6. Click Save.
A confirmation message displays with the number of records saved in the file.

7. Click OK.
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Clear the Transcript Display
The Clear Display option lets you clear all transcript messages from the table. This option does not
remove messages from the transcript database.

Click Clear > Display to remove all messages from the current view.

Clear the Transcript Database
The Clear Database option lets you remove all transcript records from the transcript database, clears
transcript messages from the table and clears the EGM selector list. Note that this action cannot be
undone.

1. Click Clear > Database.
2. Click Yes to remove all data from the transcript database, or click No to return to the transcript

without clearing the database.

42 04 MAR 2014 - Version 38

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

Chapter 4: Using the Message Transcript RAS User Guide



Chapter 5: Using the SOAP Transcript

About SOAP Messages
Simple Object Access Protocol (SOAP) is an XML-based protocol for transporting information in a
decentralized, distributed environment. A SOAP message consists of a mandatory SOAP envelope, an
optional SOAP header, and a mandatory SOAP body. G2S or S2S message content is contained within
the body.

SOAP message flow.

l Envelope - Top element of the XML document representing the message.
l Header - Generic mechanism for adding features to a SOAP message in a decentralized manner
without prior agreement between the communicating parties. SOAP defines a few attributes that
can be used to indicate who should deal with a feature and whether it is optional or mandatory.

l Body - Container for mandatory information intended for the ultimate recipient of the message.
SOAP defines one element for the body, which is the Fault element used for reporting errors.

The SOAP Transcript lets you view SOAP-encapsulated messages as they come off the SOAP stack.
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Working with the SOAP Transcript
The SOAP Transcript lets you view inbound SOAP-encapsulated messages as they come off the SOAP
stack. Here, you can see details of the SOAP wrapper around the messages plus the messages
themselves. Primarily, this transcript shows you how the endpoint (for example, an EGM or host)
constructed the SOAP around the message. It is used to debug connection issues at startup. SOAP faults
display in the SOAP Transcript and are noted in the Summary column as SOAP Exceptions.

The SOAP Transcript has several options that allow you to view SOAP information. Use the detail view
to see the SOAP wrapper and the message it contains.

At the top of the SOAP Transcript screen are several options:

l Go to Message - Type the number of the message you want to display. Click Next and Previous
to display SOAP messages, one thousand at a time.

l View XML - Click to highlight the message you want to view, and click View XML. The message
XML is displayed in a browser.

l Search Content - Search through the contents of all displayed messages in this transcript
instance for the entered text pattern (case sensitive). Clicking on a row in the returned list gives
you access to the HTTP header and message contents of the selected message. See Search the
Content of a SOAP Message.

l Clear Display - Clears the displayed messages in this instance of the Transcript. See Clear the
SOAP Transcript Display.

l Clear DB - Clears all records of this type in the database for this instance of the tool. See Clear
the SOAP Transcript Database.

The size limit of the SOAP Transcript is 4MB. If this limit is reached, messages beyond the limit are not
stored in the transcript database, and an informational message displays in the debug log.

For more information on SOAP messages, see About SOAP Messages.

44 04 MAR 2014 - Version 38

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

Chapter 5: Using the SOAP Transcript RAS User Guide



Filter SOAP Transcript Messages Using the Quick Filter
Just below the SOAP Transcript options is a magnifying glass and entry field that allows you to filter
messages based on entered data. To filter the displayed data, click inside the entry field and start
typing. The displayed data is automatically filtered as you type.

Clicking on the magnifying glass gives you a menu that you can use to provide additional selection
criteria.

This powerful tool allows you to immediately view any set of messages that you can imagine, limited
only by the data displayed in the columns.
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SOAP Transcript Column Headers
The following columns are available in the SOAP Transcript:

l Date Received - Date and time message was received by the tool.
l Host ID - Unique identifier of the host.
l EGM ID - Unique identifier of the EGM.
l Dest. Addr. - Destination Address. URL of the application that the message is sent to.
l Source Addr - Source Address. URL of the application that the message was sent from.
l SOAP Action - HTTP header value from the SOAP message. If you are having an issue with the
SOAP connection, look at the SOAP Action column and verify that the values are consistent with
GSA guidelines.

l Message Length - Number of bytes in the SOAP message.
l Summary - Actual G2S or S2S command within the SOAP message. If more than one command is
sent in a message, only the first command appears in the transcript. However, all commands with
the message are displayed in the detail view, which you can access by double-clicking the
message.

You can slide the columns around to rearrange their order. To move a column header, left-click and
hold while you move the column to it’s new location. You can also click any column to re-sort it, or use
CTRL + left-click to sort on multiple columns.

If you right-click on a column header, a menu displays that allows you to automatically resize one or all
columns (based on the displayed data in the columns), as well as to indicate which columns you would
like to display.

Clicking on any column header causes the data to be sorted using that header. Click once to sort the
column in ascending order. Click a again to sort the column in descending order. The third click clears
the sort.

If you want to sort on multiple columns, use the CTRL key when clicking the column headers.
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What Are You Looking for in the SOAP Transcript?
The SOAP Transcript lets you view SOAP-encapsulated messages, as they come off the SOAP stack.
Primarily, this transcript shows you how the EGM, Central server or Edge server constructs the SOAP
around the message. Use the detail view to see the SOAP wrapper and the message it contains.
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Load Messages into the SOAP Transcript
The Load option loads SOAP messages from the tool’s database that you can work with in the SOAP
Transcript.

If you are using RGS or RPA, be the correct EGM is selected.

1. Click Load to load SOAP messages from the database.

2. Enter the number of messages (rows) you want to view by using the arrows or by typing the
number into the combo box.

3. Click Load.

Receive Real-Time Data in the SOAP Transcript
If you select Realtime Update, the screen updates dynamically as messages are processed by the tool.
However, real-time updating may cause application slowdown.
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View the Content of a SOAP Message
By double-clicking on any row, you can examine the details of the SOAP message. The SOAP message
detail view lets you switch between a text view of the SOAP wrapper, a hexadecimal view of the SOAP
wrapper and the message’s XML content. You can also browse through the SOAP transcript list while in
detail view.

The Find option lets you search for text strings and keywords within the message. Simply click in the
Find text box and start typing. The tool instantly jumps to the first match of the entered string. This
feature becomes very handy when you want to find data in large XML messages.

l Use Find Next and Find Previous to move to the next or previous match of the entered string.
l Click Highlight to highlight all instances of the text string or keyword in the message.
l Select Match Case if you want to find only a text string or keyword with a specific case (capital
or lower case letters).
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To view the content of a SOAP message:

1. Double-click the message you want to view.
2. Click Text View to see the SOAP message details as text.

3. Click Content View to view the message content.
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4. Click Hex View to see the SOAP message details as hexadecimal.

5. Click OK to return to the SOAP Transcript. Click Previous and Next to navigate through the
SOAP transcript list while in message detail view.

6. Click OK to return to the SOAP transcript.
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Search the Content of a SOAP Message
The Search Content option lets you search for keywords within all messages currently displayed in the
SOAP transcript.

1. Type the information you want to search on.

2. Click Proceed, or click Cancel to return to the SOAP Transcript. A pop-up window displays all
messages containing the text you entered.

3. Click any message to display the SOAP envelope along with the XML message text.
4. Click Back to return to the SOAP Transcript.

52 04 MAR 2014 - Version 38

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

Chapter 5: Using the SOAP Transcript RAS User Guide



Clear the SOAP Transcript Display
The Clear Display option lets you clear all messages from the SOAP transcript. This option does not
remove messages from the SOAP Transcript database.

Click Clear Display to remove all messages from the current view.

Clear the SOAP Transcript Database
The Clear DB option lets you remove all messages from the SOAP Transcript database. Note that this
action cannot be undone.

1. Click Clear DB.

2. Click Yes to remove all data from the SOAP Transcript database, or click No to return to the
Transcript without clearing the database.
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Chapter 6: Using the API Transcript

Working with the API Transcript
The API Transcript lets you examine individual commands sent from, or received by, the RGE. The data
displayed is extracted directly from received G2S messages.

A quick filter option lets you narrow the displayed messages by the typed characters, commands or
words. You can clear the Transcript display by clicking the Clear option.

Use the EGM Selector to clear any selected EGM ID if you want RGE to stop adding that EGM to the
displayed EGMs in the API Transcript.

Note: The EGM Selector affects what is displayed in the RGE user interface only. EGMs continue
to communicate with RGE whether they are displayed in the user interface or not. Displaying
fewer EGMs may improve user interface performance.

The size limit of the API Transcript file is 400 MB. Once that limit is reached, older records are purged.
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API Transcript Column Headers
The following columns are available in the transcript:

l Comment - Information entered by the user about a specific message. This field is not part of the
actual message. Comments exist only in the tool in which they are entered.

l Date Received - Date and time message was received by the tool.
l EGM ID - EGM identifier.
l From - Identifier of entity (for example, EGM or host) that sent the message.
l Message ID - Identifier associated with message.
l Summary - Actual G2S or S2S command within the message. If more than one command is sent
in a message, only the first command appears in the transcript. However, all commands with the
message are displayed in the detail view, which you can access by double-clicking the message.

l To - Identifier of the intended target of the message.
l Transport Info - Displays the URL for the associated message. For outbound messages, the
Transport Info is the RGE sending the message; For inbound messages, it is the URL that RGE
received the message on.

You can slide the columns around to rearrange their order. To move a column header, left-click and
hold while you move the column to it’s new location. You can also click any column to re-sort it, or use
CTRL + left-click to sort on multiple columns.

If you right-click on a column header, a menu displays that allows you to automatically resize one or all
columns (based on the displayed data in the columns), as well as to indicate which columns you would
like to display.

Clicking on any column header causes the data to be sorted using that header. Click once to sort the
column in ascending order. Click a again to sort the column in descending order. The third click clears
the sort.
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Filter Transcript Messages Using the Quick Filter
Just below the API Transcript options is a magnifying glass and entry field that allows you to filter
messages based on entered data. To filter the displayed data, click inside the entry field and start
typing. The displayed data is automatically filtered as you type.

Clicking on the magnifying glass gives you a menu that you can use to provide additional selection
criteria.

This powerful tool allows you to immediately view any set of messages that you can imagine, limited
only by the data displayed in the columns.
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View Message Details
By double-clicking on any row, you can examine the details of the command in that row. The message
detail view lets you switch between a content view (for future use), a text view and a hexadecimal view.

In text view, you can use the Find option to search for specific text strings. As you type, the first
instance of the matching character(s) are highlighted in the message text. You then have the following
options:

l Click Find Next and Find Previous to move between instances of matching text.
l Click Highlight to highlight all instances of matching text.
l Select Match Case to highlight text that matches exactly.

Click OK to exit the screen and return to the API Transcript.

Clear the API Transcript Display
The Clear option lets you clear all messages from the transcript. This option does not remove messages
from the transcript database.

Click Clear to remove all messages from the current view.
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Appendix A: Customizing RAS

About RAS Configuration Options
While RAS is configured to work "out of the box," you can use the configuration options to customize it
for you specific analysis needs. All configuration options can be accessed by clicking Configure on the
menu bar at the top of the main screen.

Configuration options are grouped as follows:

l Desktop Options - Options that affect the amount of information loaded into transcript and log
displays, which may affect performance.

l Engine Options - Configure the initial and maximum amount of memory used by RAS for
processing data.

l Artifact Analysis Tool Options - Options that affect which information is displayed automatically
in the tool when you load a ZIP file.

l License Manager - Displays information about the currently loaded license and allows you to load
a new licenses into the tool.

Configuring Desktop Options
Desktop Options define default application views, which are comprised of one or more available
objects. This screen also allows you to define the amount of data displayed in specific transcripts and
views.

Default Desktop
This section lets you choose the desktop loaded at startup (Default Desktop). A desktop is a collection
of layouts (for example, the Transcripts layout), with each layout containing one or more objects. Each
desktop contains layouts specific to the specified protocol and license features.

To change the desktop:

1. Go to: Tools > Configure > Desktop Options
2. At Default Desktop select the desktop you want to use.
3. Click OK.
4. Restart the tool.
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Start in Full-Screen Mode
This option lets you choose whether you want RAS to start up at full-screen size or a smaller screen
size. Clear this option if you do not want RAS to start up at full-screen size. By default, this option is
selected.

Transcript and Log Messages Displayed
This section allows you to specify the amount of data used for various transcripts and views. Note that
increasing data size increases the memory used by the tool.

l Max G2S Transcript Messages - Maximum number of Message Transcript messages displayed.
l Max Soap Transcript Messages - Maximum number of SOAP Transcript messages displayed.
l Max Logger Lines - Maximum number of lines in the Debug Console stored in the database.
l Max Watcher Data Versions - Maximum number of matches for each Watchable stored in the
database.
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Configuring RAS Engine Options
From Engine Options, you can configure the initial and maximum amount of memory used by RAS for
processing data, and edit the CVT network location so you can view CVT test case information.

To configure memory in RAS, simply type or select the amount of memory, in megabytes, that is
required for the data you are importing. The default for both fields is 512 megabytes.

Note: To determine how much memory is required, look at the size of the ZIP files you are
importing. For example, if you are importing large amounts of data into RAS, you may want to
raise the memory. On the other hand, if you are running RAS on a smaller computer, you may
want to lower the memory allocated to RAS.

To configure the network location of the CVT installation, click the CVT  Installation Location drop-
down arrow, and navigate to the CVT installation directory. Once you select the network location and
restart RAS, you'll be able to launch test case information from the CVT Test Case Encyclopedia from the
Message Transcript's message details screen.

Configuring Artifact Analysis Tool Options
Artifact Analysis Tool Options let you configure what and how information is displayed on the Artifact
Analysis Tool tab. You can choose whether to display ZIP file content in a tree structure that you can
then browse. You can also choose to automatically display the transcript file and debug log in subtabs
for easy viewing.

Note that if all three options are cleared, you will not be able to access the uploaded content.

04 MAR 2014 - Version 38 61

Copyright © 2014 Radical Blue Gaming, Inc. All rights reserved.

RAS User Guide Appendix A: Customizing RAS



l Show Debug File Explorer on Restart - Select this option to display ZIP file content in a tree
structure that you can browse. By default, this option is cleared.

l Autoload Message Transcript File on Import - Select this option to automatically display the
loaded message transcript file in a subtab on the Artifact Analysis Tool. By default, this option is
selected.

l Autoload SOAP Transcript File on Import - Select this option to automatically display the
loaded SOAP transcript file in a subtab on the Artifact Analysis Tool. By default, this option is not
selected.

l Autoload Log File on Import - Select this option to automatically display the loaded debug log
file in a subtab on the Artifact Analysis Tool. By default, this option is selected.

l Autoload Files on Restart - Select to autoload the transcript file, SOAP transcript file and log
file when the tool restarts. Note that the corresponding Autoload . . . on Import option must
also be selected for the file to load.

l Use Database for Processing Transcript Files - Select this option to improve tool
performance when processing large transcript files. By default, this option is not selected.
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Configure License Manager Options
License Manager displays current licensing information, including the product features available under
the license. The New License File option allows you to upload a new license file for the product.

License Details

l Company Name - Name of organization that purchased this license.
l Contact Name - Name of person license was issued to.
l Customer ID - Unique company identifier.
l Expiration Date - Date that tool becomes invalid.
l Expires In - Time left until license expiration.
l Features - Click View Features to see which features are enabled for your license.
l Is Production? - True indicates that the license is a fully licensed version.
l Is Valid? - True indicates that the license is valid; False indicates that the license is invalid.
l Issued On - Date of license issuance.
l License Number - Unique license identifier.
l License Month - Month that license expires.
l License Year - Year for which license is valid.
l Load Message - Status of license upload.
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l Location ID - Location of purchasing organization.
l MAC Address - Physical address of computer on which the tool is installed.
l Product Line Key - Unique identifier of installed tool.
l Product Name - Name of licensed RadBlue product.

Load a New License File
To use the latest version of the tool, you may periodically need to update your license.

To load a new license:

1. Click the drop-down arrow.

2. Navigate to the new license file.
3. Highlight the new license file, and click Open.
4. Click Apply or OK to install the new license.
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Appendix B: Troubleshooting

About the Debug Console
The Debug Console displays all informational, warning and critical errors that occur in the tool. Any of
the following message types may appear in the Debug Console:

l INFO - Messages that do not impact the system, but may be useful to know. INFO messages
appear in black type.

l DEBUG - Fine-grained informational events that are useful in troubleshooting. DEBUG messages
appear in black.

l ERROR - Messages related to program errors. ERROR messages appear in red.
l FATAL - Designates a severe error events that will presumably lead the application to abort.
FATAL messages appear in red.

l UNKNOWN - Messages that have not been assigned a logging designation. UNKNOWN messages
appear in pink.

l WARN - Messages that indicate potentially harmful situations. WARN messages appear in blue.
You can clear the debug log and filter the debug log display (selectively display messages by warning
level) as needed.

The information displayed in the Debug Console is written to a text file ([tool name].txt), located in
the tool’s logs directory.

You can specify the maximum number of lines included in the log through the Configure option under
Tools on the menu bar.

1. Go to: Tools > Configure > Desktop Options > Max Logger Lines
2. Click Desktop Options.
3. In the Max Logger Lines field, type or select the maximum number of lines in the Debug

Console.
4. Click OK.
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Clear the Debug Log Display
To clear the Debug Console display, click Clear Log.

Note that this option clears the display only, and not the text file associated with the Debug Log ([tool
name].txt, located in the tool’s logs directory).

Filter Debug Messages
The Filter option lets you specify the type(s) of messages you want displayed in the Debug Console.

To filter Debug Console messages:

1. From the Debug Console, click Filter. The Logging Filter screen appears.
2. Click Select All to select all message types.

or

1. Click Clear All to clear all boxes, and select the message types you want to display.
2. Click Apply for your changes to take effect, or click Cancel to exit the Logging Filter without

applying any changes.
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What to Do If You Can't Resolve an Error
The Export Debug option lets you create a ZIP file containing all the files that the RadBlue support
team needs to troubleshoot product issues or for use in the RadBlue Analysis Suite (RAS). The ZIP file
includes data from the time the tool was started to the time you select the Export Debug option.

1. Go to File > Export Debug.

2. A Debug-[product-x.x.x]_[user ID].zip file is exported to your computer’s desktop.
3. Attach the ZIP file to an email, along with a description of the issue, and send it to

support@radblue.com.
or

Go to www.radblue.com/support, complete the support form, attach the ZIP file and send.

You will be contacted about your support issue within one business day.
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